S |
If

Gr User Manual
May 1, 2002

by John M. Donovan



INEFOAUCLION . . . . e e e e e e e e e e e e e e e e e e e e e e e e e e e 1

Download and Installation . .......... ... 1
System ReqUITEMENES . . . .. oo ot 1
Installing and RunningonaPC .. ... ... ... . . . 1
Working in Gr . .. ... 3
Using Multiple Pages . ... ... 3
OpeningaFile .. ... ... . 3
Displaying Data . .. ... ... 4
Graph Layout . . .. ... 5
Changing the Graph Layout .. ...... ... . e 5
The Properties Dialog ... ........ ... . . 6
Dialog Layout . . . ..ot 6
The GrObject Tree .. .. ..ot e 7
The Properties Table .. ...... ... .. 8
Common Object Properties . ............o e 9
MOOES .. 12
Zooming and Panning . .. ... .. ... 13
Zooming with the MOUSE . .. .. ...t 13
Z00m COMMANGS . . . .ottt et e e 13
The Status Bar . .. ... ... 14
The Default Status Bar . . ... ... 14
The Detailed Status Bar . ...... ... 15
Selecting and Dragging DataPoints . ............ .. ... ... ... ... .. . . . ... 17
Selecting POINtS .. ... i 17
Deleting POINES . . .. ..ot 18
Dragging POINtS . . ... .. i 18
The Modify Dialog . ......... ... 18
Choosing an OPeration . ... ... ...ttt i 19
1= 7] = 1 o o 20
OULPUL .. e 20
Cutting, Copying, and Pasting Curves . .. ......... ... ... . . i 22
Undoing Operations . . .. ....... ... e 23
TO0IS 23



Drawing New CUIVES . . . ..ot et 24

Page Formats . ... ... ... .. e 25
Saving as XML . .. ... 25
Savingas GS Format . . ... ... . 26
P INEING . o 26
T amMPlatES . . . 29
Appendix A - File Format Descriptions . ............. ... ... ... ... . . ... 29
Gr XML Format . . . ... ... 29

GS Format . .. ... ... 31
Readingthe Header ........ ... . .. .. . 31

Readingthe Body . ........ . 32

Writing GS Format ... . 32
Otherdataformats . .......... ... . ... .. . . . . 33
Appendix B — Scripting . . ... ... 35
Appendix C — Tips for Working with RGB Colors ................................ 37
Appendix D — Symbol Indexes . ........ ... . .. . .. 39

Appendix E — Contact Information ............ ... ... ... ... ... ... . . . .. 40



Introduction

Gr' is a visualization and analysis application for displaying, editing, and printing X-Y
data. It can also be used to display or animate vector data, particle paths, or two-dimensional
(2D) data fields. Gr is often used with time series data, but it will work with any data that
describes Y as a function of X. Gr allows you to zoom in and out and pan within a graph. It also
offers several ways to edit or manipulate the data.

Gr was written by John Donovan for use by members of the U.S. Geological Survey
(USGS) San Francisco Bay Hydrodynamics Project in Sacramento, California. The program
reads several data formats. Gr is written using the Java 2 platform, OpenGL, and GL4Java. It
runs on several platforms, including Windows.

Download and Installation

In order to use the latest version of Gr, you must download it from the Gr web site at
http://ca.water.usgs.gov/program/sfbay/gr/. Under the Downloads heading, look for your
platform and download the required distribution files.

Everything you need to run Gr is in the distribution. The Gr web site has links to one or
more files for each supported platform. The first file is a base installation that includes
everything Gr needs to run. The other files contain updates to portions of the base installation.

System Requirements

In order to run Gr, you will need the Java 2 platform installed on your computer. If you
do not already have it, there is a link to it on the Gr web site. The recommended configuration for
Windows is a Pentium III with 256 MB of memory and a graphics card that performs geometry
acceleration. You should be running in 16-bit color mode, or higher, at a resolution of at least
800X600. Gr should work on all versions of Windows.

Due to lack of demand, the latest version of Gr is not available for platforms other than
Windows. Older versions of Gr are available for Solaris for SPARC, SGI Irix, and Linux for
x86. To obtain the latest version of Gr for these platforms, contact the author.

Installing and Running on a PC

Download and install the Java Runtime Environment (JRE) and make note of its location.
Download and unzip the jre_addons.zip file to the JRE directory, for example “C:\Program
Files\Java\j2re1.4.0”. This will add Java archive (JAR) files to the JRE lib\ext directory and
OpenGL dynamically-linked library (DLL) files to the JRE bin directory. Download and unzip
the gr_win.zip file to C:\, and a C:\Program Files\USGS\Gr directory will be created that includes
the Gr libraries and documentation. If you are installing an update, make sure all prerequisite
base and update distributions are installed in chronological order, so they will simply write over
existing files. Under Windows 95 or 98, you may need to right-click on the C: \ G'\ gr . bat file,
choose Properties..., and change the conventional memory from “Auto” to the maximum setting.

pronounced "Jee Arr"
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To run Gr, you must execute the gr . bat file in the Gr directory. The most convenient
way to do this is to first create a shortcut to the batch file on the desktop. This can be done by
dragging the batch file from the Gr directory and, while holding down the Control and Shift keys,
dropping it on the desktop. There is a Gr icon image in the G\ r es directory called
gr 64X256. i co that can be used with the shortcut or Gr data files. To use it with the batch file,
right-click on the shortcut and choose Properties. On the Shortcut tab, click Change Icon... and
select the gr 64X256. i co file.

You can start Gr by double-clicking the shortcut or batch file or by typing gr in a
command window. The latter requires that the Gr directory be in the path. You can also start Gr
by dropping a data file on the Gr icon or batch file or typing gr . bat filename. If you do not give
a filename, Gr will bring up an Open dialog box when it starts.

Two windows will probably appear when you start Gr under Microsoft Windows. One is
the Gr application itself, and the other is a DOS window which Java uses for writing console
output. If you receive error messages, open the gr . bat file and check that the paths to the Gr
directory and the Java directory are correct.

To associate the icon with Gr files, open My Computer and choose o
Options... from the View menu. Under the File Types tab, click New Type... and r
then click the Change Icon... button. Select the gr 64X256. i co file and click OK, | ¥ A&

In the Description of type field, type Gr Script and type . gr s in the Associated The Gr Icon
extension field. Under Actions, click the New... button and type open in the Action

field. Under the Applications used to perform action field, type C: \ G-\ gr . bat and click OK to
close the New Action dialog and again to close the Add New File Type dialog. You can repeat
these steps to associate other files with Gr, such as . gs files or . xm files. Once the associations
are made, you can open the files in Gr by simply double-clicking them.

Gr is set up to work with JRE 1.4.0. In other versions, such as 1.3, the Gr keyboard
shortcuts may not work, or other features could be missing. To use a different version of the
JRE, open the gr.bat file in a text editor and modify the JRE variable to point to desired version
of java.
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Working in Gr

Gr uses a page metaphor to show [ sample.xml - Gr ' ol x]
multiple graphs the way they would appear [guam | sers e s
1 ’ ¢ Open File... !
on a prlgted page. It’s n’f)t exgc’tly what ﬁ e e
you see is what you get,” but it’s close. Save \
The page area has a default color of black? —
and takes up most of the Gr window. ALY
. Page -1
Several menus are listed across the top, and | e | I /
there is a column of buttons down the left —— R :
side. Clicking any of the buttons is the Graph o st o s e
. New :
same as choosing a command from the show
menu, or using the keyboard shortcut. — .. vany
Status information is given at the bottom of | seeston — ** —
the window. ‘ '::I:g | .10
Mode 005
H i () Pan
Using Multiple Pages e
} Select 105 108 107 108 109 10 m 12 13 14 15
h
Gr Can haVe any number Of pages < More = 113.87500 , 0.13330 Zoom X Unlocked || ¥ Unlocked

open, but it only displays one at a time. To
create a new page, click the New button
under the Page heading on the toolbar, or
choose New Page from the Page menu. Once multiple pages are open, you can cycle between
them by clicking the Next button under the Page heading. To delete the current page, click the
Delete button under the Page heading and then click OK on the confirmation dialog that appears.

The Gr Program

Any operation you perform in Gr usually only affects the current page. An exception to
this would be whenever an operation is undone that was previously applied to a different page.
Also, since the same object can appear on multiple pages, changing it on one page will cause it to
change wherever it appears.

Opening a File

To open a file, click the Open File... button, or select it from the File menu (Ctrl-Shift-
0O). A dialog box will appear showing the directory of the last file opened or, if none has been
opened, the user’s “My Documents” directory.

Using the Open File dialog, navigate to the File Options
directory containing the data file to be opened, and double- Fenpe
click on it. Once you have chosen a file, Gr will usually §_|9W-“SQS-9'-data-De'im“BdD_a‘?F_i'?| _| '|| options... |

display the File Options dialog box to confirm what type  [® overlay C New Page _|...._0K mlmcéncélw

of file is being opened, and to give the option of either File Options Dialog

2 The figures in this manual use a white background so they will look better when printed.
They are also shown with the Metal Look and Feel (LAF). The appearance of the buttons and
other components will vary depending on the LAF that is selected. See the section on Setting
Default Configurations for information on changing the color scheme and LAF.
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overlaying it on the current page or opening it on a new page. For certain file types, additional
options are available by clicking the Options... button. If no options are available for the selected
file type, the Options... button will be disabled.

The exception that keeps the File Options dialog from being displayed is if the file ends
in a known extension. Currently, the recognized extensions are .XML for XML project files, .GS
for GS data files, and .GRS for Gr script files. These files are opened without showing the
confirmation dialog and are overlaid on the current page. If an XML project file is opened, and it
defines its own page, then a new page will be created.

Before Gr actually opens the file, it checks for a script file called gr_config.grs in the
same directory and executes it if it is present. Typically, the configuration file would set the
default data format with a line similar to the following.

SetFormat "gov.usgs.sfhydro.data.CR1l0DataFile"

After reading the configuration file, Gr opens the data file itself. If the file can be opened,
it’s data will be displayed in one or more graphs on the screen. If there is a problem opening the
file, an error dialog will appear, or error messages will be written to the screen. Error messages
may show up in a DOS or UNIX shell window or in a Java console log, depending on your
platform.

You can open multiple files at once by holding down the Control key and selecting the
files in the Open File dialog. They will be opened in alphabetical order just as if they had been
opened individually.

Displaying Data

When a file is opened, one or more graphs are stacked vertically on the screen. Each
graph has it’s own Y-Axis, but shares a common X-Axis. Only the bottom graph is allowed to
display labels or a title on it’s X-Axis. In the future, Gr will be able to display multiple columns
of graphs, but for now it just uses one column with any number of graphs.

Gr attempts to place curves of the same data type on the same graph, regardless of which
graphs are selected or hidden. GS format files allow data to have a type, and if a new data type is
encountered, a new graph will be created for it and added to the page. Gr looks at the data type
of the first curve within a graph to determine the data type for that graph. If the new data are not
visible after overlaying, try showing hidden graphs or giving the Zoom All command. Also,
check if the new curve is being drawn over another.

When multiple curves are added to a graph, each uses a different color and line pattern.
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The colors are

Green
Magenta
Cyan
Yéelow
White
Red

After that, additional curves are red.

OO WNPE

The line patterns are

Solid

Dashed

Dotted

Dash-dot

Loose dash

Loose dotted

Dash-dot-dash

Tight dashed

Tight dotted.

After that, additional curves are solid.

©CoO~NO O~ WNE

If any curve is completely empty, its endpoints are automatically restored with Y values
of zero. This allows the ends to be selected and the interior points to be restored. To delete these
curves, use the Cut command as described under “Copying Curves and Undoing Operations.”

Graph Layout

Each graph consists of a rectangular frame, curves representing data, and optional labels,
tick marks, and grid lines. The graphs are stretched to fit the page and are numbered from the
bottom of the page upward, starting at one. Hiding or showing a graph does not change it’s
index number, but deleting or moving it does.

At any given time, one or more graphs are selected for action. Selected graphs are
indicated with dark green markers at the left corners of their areas of the page. To select a graph,
move the mouse over it and press any mouse button. This will deselect all other graphs. To add
a graph to the current selection, hold the Control key down and select the additional graph.
Holding down the Alt key will deselect the graph beneath the mouse pointer, and select all
others. Holding down Control and Alt together works the same as holding down Alt, but
previously deselected graphs will remain deselected. When editing points in Select mode, only
one graph can be selected at a time.

Changing the Graph Layout

Once a graph is selected, it can be hidden or deleted. To hide a graph, select it and press
the Hide button under the Graph heading on the tool bar, or select Hide Graph from the Page
menu (Ctrl-H). To delete the graph, select the graph and press the Delete key on the keyboard,
click the Delete button under the Selection heading on the tool bar, or choose Delete from the
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Edit menu. A dialog box will appear to confirm the action. If points or curves are selected
within a graph, the delete key will delete those points, not the graph itself.

To show a graph that has been hidden, press the Show button under the Graph heading on
the tool bar, or select it from the Page menu (Alt-S). The hidden graph with the lowest index
will be restored to the spot on the page indicated by its number. For example, if graphs 1 and 3
are showing, and graph 2 is hidden, graph 2 will be restored to it’s place above 1 and below 3.

To move a graph to a different [® sample.xml - Gr [ [_[O]x]
location on the page, move the mouse T oL tow P Took few
pointer to within a few pixels of the left ,% .
edge of the graph’s area, and wait for a gray | sae L~
bar to appear. When it does, press and hold | 525e™ **[ [ . st s
either the left or right mouse button, and how- || L] ~ ~
drag the graph to the desired location. As e ' ,r | i( \'l il |( \'1 "‘1 fr \', ,\‘ [( \'l f\‘ ,(\1 jn[ ,ln| |r
the graph moves, other graphs will move t0 | yu - jj '{l }l U U 11 ) U | U !L U ll / U ll |
make room for it. When the mouse button |G N
is released, the graph will snap into the =
empty slot. Dragging the mouse pointer Out | g | ., &tn e s )
of the page drawing area also will cause the ,% N
selected graph to snap into the empty slot. IF S
New, empty graphs can be created =5 )
by clicking New under the Graph heading =~ 5%t ® —5e 5 w1«
on the toolbar, or selecting New Graph s | - e e

(Ctrl-N) from the Page menu. Anempty  Moving a Graph

graph will be created and added to the top

of the page and given the next available index number. See the sections on overlaying data files,
pasting curves, and the draw command for ways to add data to the empty graph.

The Properties Dialog

Virtually every object displayed in Gr can be controlled using the Edit Properties dialog
box (Properties Dialog). To open the dialog, click the Properties... button on the toolbar, or
select it from the Page menu (Ctrl-Shift-R). The initial size of the dialog is proportional to your
computer’s screen size, but the dialog can be resized after it is open by dragging its sides or
corners with the mouse. The dialog box is “modal,” meaning that the main Gr window will not
respond to input until the dialog is closed.

Dialog Layout

The Properties Dialog is divided into two areas: a tree pane and a table pane. Scroll bars
automatically appear around the edges of these areas if they hold more information than can be
displayed at once. A splitter bar separates the two areas and can be dragged with the mouse to
adjust the amount of space given to each area.
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There are three buttons at the bottom of the dialog box
for closing it and applying changes. The OK button applies all G?"g w
the changes in the dialog box to the affected objects and then ? ég;:;:g:ﬂ:ﬂer
closes the dialog. The Apply button applies all the values so

Ps postseript Options
they can be seen in the main Gr window but leaves the dialog

box open so other modifications can be made. The Cancel b o 0817 »
button closes the dialog and forgets all changes that were not yet ¢ ?@%ﬁibifs?{e:prEu s
i I2, Dimension 0:
appllaj ﬁg\mension 10: >
The Gr Object Tree
. . . Title SPEED, FTrg
The upper pane of the Properties Dialog contains an Showing v
. . ei1 . Show Line v
expandable tree representing every object Wlthln Gr. Every P ,
object has a parent, and some objects have children. The Line Patiern [Soia -
hierarchy displayed in the pane shows the objects the same way [ ™" H }
they are stored by Gr and would be saved in an XML file. Symbol Type Single Pixel -
Calor Yellow 7
The exact appearance of the tree is dependent upon the ok || away || cancel |

current Java LAF, however, there are always certain similarities
in the way the tree is drawn. Each node is drawn on a line by
itself that contains an icon, a short, generic description, and an
optional title. If the node has children, a marker is drawn to the left of the icon which indicates
whether the children are currently being shown. To expand a node, so that its children are
showing, click once on the marker. To collapse it, so that the children are hidden, click the
marker again and it will toggle back to the original state.

The Properties Dialog

To select a tree node, simply click anywhere on its icon or name. This deselects any
previously selected nodes. To select more than one node at a time, hold down the Control button
and click on each additional node. To select a continuous range of nodes, click the first node,
hold down the Shift key, and then click on the last node.

Once one or more nodes have been selected, you can right-click to display a context-
sensitive menu. If there are no nodes selected, the menu’s only command is “Apply All
Changes,” which is the same as clicking the Apply button at the bottom of the dialog. If one or
more nodes is selected, the menu will contain the additional items “Cut” and “Copy”.

Choosing “Cut” from the right mouse menu removes the selected nodes from the tree and
stores them in the Properties Dialog’s own clipboard, removing any other nodes that were there
before. The “Copy” command does the same thing without removing the nodes. Once nodes
have been added to the clipboard, they can be added as children to any other node. To do this,
click on the target parent node or nodes, and right click. The menu will have two additional
items: “Paste Original” and “Paste New Copy.” The “Paste Original” command adds a shared
instance of every node in the clipboard to every selected node. The “Paste New Copy” command
creates a deep copy (including children) of every node in the clipboard and adds the copies to
every selected node.

To add a new object to a selected node, right click and browse through the “Add New”
submenu. Currently, only a few object types are available, such as “Page” and “Graph”.
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All the changes to the nodes are stored up and applied when the user clicks “Apply” or
“OK,” and discarded if “Cancel” is clicked.

Certain object types will show an additional menu item when you select them and right
click. For instance, file objects show a “Gr File” submenu with items “Save” and “Save As.”
This is relatively rare in the current version of Gr, but any node has the option of displaying it’s
own menu, So more context sensitive commands may be added in the future. Since these
commands are applied immediately to the object, any other changes should be applied first, and
these commands should be used with care.

Occasionally, the tree in the Properties Dialog will not accurately show the structure of
underlying objects. This usually happens when pasting on second instance of an object when
there is only room for one, or when giving a menu command such as “Calculate.” An example of
the first case is when pasting a Zoom object into an Axis object. An Axis can only have one
Zoom child, but both will be shown until you close the Properties Dialog and reopen it. An
example of the second case would be when giving the “Calculate” command on a
ParticleAnimationCalculator object. The calculator adds a new ParticleAnimation object to
itself, but it isn’t visible until the Properties Dialog is closed and reopened.

The Properties Table

The lower pane of the Properties Dialog contains a table with two columns and a variable
number of rows. The left column has the heading “Property” and the right column has the
heading “Value.” You can adjust the size of the columns by clicking on the dividing line
between the headings and dragging to one side or the other.

The properties displayed in the table depend on which nodes are selected in the tree pane
above it. Each object has its own set of properties. If more than one node is selected, the table
looks through their property lists for properties with the same name and only displays those. For
example, if a Graph and a Page of Graphs is selected, the only properties they have in common
are “Title” and “Show Title,” so those would be the only ones displayed in the table. If the
current values of the properties vary between the selected objects, the values of the first node
selected will be displayed. This allows multiple objects to be changed at once.

None of the changes made to the properties are applied to the original objects until the
“Apply” or “OK” buttons are clicked. Even then, the only properties that are applied are the ones
that were edited by the user since the last Apply event.

Some bugs remain in this dialog box, but it is still very usable as long as you are aware of
them. After changing the value of any table cell, you must press the Enter key or click in another
table cell. If you do not, the change will not be registered, and the values for other objects could
become corrupted.

For all the text fields, you can use the standard Windows keyboard shortcuts of Ctrl-X to
cut, Ctrl-C to copy, and Ctrl-V to paste. You can type values that are longer than the text fields
themselves, but you must use the arrows on the keyboard to move the cursor within the field.
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Common Object Properties

The children of the root Gr object usually consist of one GUI object, zero or more Page
objects, and zero or more File objects.

The GUI object controls certain options in the Gr Graphical User Interface. There are
two properties associated with it.

GUI Look And Feel

Levels of Undo

Causes the program to resemble a particular window system such
as Microsoft Windows or Motif. The default is Metal, the main
LAF for Java on all platforms.

The number of operations that are stored that can be undone later.

File objects, such as XMLProjectFile, contain links to other objects in the hierarchy. The
children are displayed generically, and their properties cannot be edited. The properties of the

file itself include:

Title
File

The type of file. This cannot be edited.

The name of the disk file to which the data would be saved. This
button brings up a file chooser dialog that is used to choose a file
name without saving anything to disk. To be safe, apply changes
to this property before saving the file.

The Page of Graphs object contains three properties. The first two, Title and Show Title,
are found in nearly every graphical object.

Title
Show Title
Formatter

The title of the page

Whether to show the title.

The Java class that should be used to format the page and the
objects on it. The default is PageFormatter. Alternatives include
Wor kingFormatter and ReportFormatter. Formats can also be
applied from the Tools menu.

Pages can have a number of child objects. They always have one formatter and one
PostScript Options child. They can also contain graphical objects, especially Graph objects.
Most of the page formatters have no options. The VariableSzeFormatter has at least one

property.

Number of Values

Pct. Size of Graph 0

The number of graph for which the formatter will make space.
Extra graphs are assigned the remaining space. You will need to
close the Properties Dialog and reopen it after you increase this
value to see the new Pct. properties.

The percentage of the vertical area that should be given to Graph 0.
The Number of Values property determines how many Pct. Of
Graph X properties there will be.
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The PostScript Options object has several properties that control how a page would be
formatted when saved to a PostScript file. They include the following:

File Name The default file name for saving PostScript output.

Landscape Orientation Whether to rotate the plot to use landscape orientation.

Font The name of the PostScript font to use.

Font Size The size of the PostScript font to use.

Color Curves Whether to draw each curve the same color it is on the
screen (slightly darker so it will appear on a white page).

Color Background Whether to draw the background the same color as it is on
the screen.

Line Width The scale to use for thickening or thinning lines. For

curves, the screen line width is multiplied by this number to
convert from pixels to points.

Uniform Line Width Whether all lines should be drawn the same width.
Symbol Size The scale to use for drawing symbols on curves.
Reduce Points on Lines Whether to apply the point reduction algorithm to lines.

Line Reduction Tolerance =~ The width scale parameter for point reduction of lines.
Reduce Points on Symbols  Whether to apply the point reduction algorithm to symbols.
Symbol Reduction Tolerance The width scale parameter for point reduction of symbols.
Debug Point Reduction Whether to show before and after data for point reduction.

See the manual section on Printing for further information.

Graph objects contain one X Axis, one Y Axis, and any number of graphical objects,
especially Curve objects. Each graph has the following properties:

Title The title that is written above the graph.

Show Title Whether to show the title.

Showing Whether the graph itself should be shown on the page.

Show X Labels Whether the X axis labels should be drawn. This is overridden by

the all page formatters except VariableSzeFormatter.

The X Axis and Y Axis objects each contain one Zoom object, which describes the limits
and tick increments of the axis. The axes themselves have the following properties:

Title The title that should be displayed. A ‘\n’ represents a line break.
Show Title Whether to show the title next to the axis.
Dimension The dimension with which this axis is associated (0 for X, 1 for Y).

This property is not editable.
Show Major Ticks ~ Whether to show the major tick marks.
Show Minor Ticks ~ Whether to show the minor tick marks.
Show Labels Whether to show numbered labels beside each major tick.
Show Grid Whether to show grid lines at each major tick mark.
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The Zoom object controls the area that is displayed in the graph, as well as the tick and
label increments used on the axes. It has these properties:

View Min
View Max
Outer Min
Outer Max
Major Inc
Minor Inc
Tick Offset
Unit Scale
Label Format

The lower bounds of the current view.

The upper bounds of the current view.

The lowest value the graph can display by panning.

The highest value the graph can display by panning.

The increment between major tick marks.

The increment between minor tick marks.

The starting point from which major ticks are measured.

The multiplier for units displayed on the axis.

A string describing the precision to use for the number labels. For
example, “0” indicates no decimal place, “0.00” indicates two
decimal places, and “0.0#” indicates at least one place, and at most
two, depending on the number. It is further described in the Java
documentation for the class j ava. t ext . Deci mal For mat .

The Curve object controls how a two-dimensional data series is drawn within a graph.
Each contains one data series object, which stores the X-Y data.

Title

Showing
Show Line
Line Width
Line Pattern

Show Symbols

Symbol Size
Symbol Type

Color

The title of the curve. This is shared with the underlying data
series, and is used to identify each curve when there are many
others on the page.

Whether the curve should be drawn on the graph.

Whether to draw a line connecting each data point.

The width of the connecting line, measured in pixels.

The line pattern to use. A list of possibilities are provided in a
drop-down box.

Whether to draw symbols at each data point

The diameter of the symbols in pixels

The type of symbol to draw. Any symbol other than a Square or
Single Pixel is drawn as a square on the screen, but is drawn
correctly in PostScript output. A list of possibilities are provided
in a drop-down menu.

The color of the curve. A list of possibilities are provided in a
drop-down menu. The last choice is “Other...” which displays a
dialog box for choosing a color. By clicking a tab at the top of the
dialog, the color may be specified by picking it from an array of
color cells, in HSB format, or in RGB format.

Data series objects store multidimensional data, and appear in the form of DataSeries,
XyDataSeries, or TimeSeries objects. Each contains one child Dimension object for each of the
dimensions. The series own properties include:

Title

The name of the series used to keep track of it amongst the
others.

USGS Gr User Manual Page 11 of 40



Number of Dimensions The number of dimensions stored in the series. This is for
the user’s information, and is not editable.

Number of Points The number of points stored in the series. This is for the
user’s information, and is not editable.

Number of Points Selected The number of points in the series which are currently
selected for modification. This is for the user’s
information, and is not editable.

TimeSeries objects have the additional property:

Reference Year The year from which all time dimensions are referenced.

A Dimension object describes and controls one dimension of a data series, such as the X
dimension. It has the following properties:

Dimension Number The dimension with which this axis is associated (0 for X, 1 for Y).
This property is not editable.

Title The name of the dimension, if it has any special significance

Snap The increment that data should snap to when being edited

Snap Offset The starting point from which snap increments should be measured

Locked Whether a dimension should be locked so that data cannot be
changed.

Sorted Whether the dimension is arranged in order from lowest to highest
value. This property is not editable.

Min The minimum value present in the dimension. This property is not
editable.

Max The maximum value present in the dimension. This property is not
editable.

Modes
Gr mainly operates in one of three modes. These are Pan, Zoom, and Mode

Select and are controlled with radio buttons on the toolbar. The current mode is |7 pan
always displayed as the selected radio button. You can change the current mode @ Zoom
by clicking on one of the other radio buttons. To learn how each mode functions, ) select
see the sections of this manual on Zooming and Panning, and also Selecting and

Dragging Data Points. Mode Panel
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Zooming and Panning
You can use the mouse to zoom in and pan ! s rstps suers ety
around each graph. Each time you zoom in or out,
the tick and label increments for each axis are »
recalculated to suitable values. These values are /\
determined partially by the size of the Gr window o o~ =
itself. Therefore, resizing the window can change ..
what the program considers to be a suitable o

incrm]mt Y 975 1000 1025 1050 1075 1100
Selecting an area for zooming

NS

Zooming with the Mouse

To zoom in on a graph, hold down the Shift button, and move the mouse to the corner of
the area you want to zoom in on. While keeping the Shift button down, press and hold either the
left or right mouse button. Drag the mouse to the opposite corner of the zoom area and release
the mouse button. You will see a dashed rectangle following the mouse, but you do not have to
wait for it to appear exactly where the mouse is. Gr will use the position of the mouse, not the
dashed selection rectangle, to determine the corner of the zoom window. Keep the Shift key
down until the zoom operation is completed.

To zoom in without using the Shift button, click the Zoomradio button within the Mode
panel on the toolbar. Then define the zoom window with the mouse the same way that is
described above. Once the zoom operation is completed, Gr will automatically switch to Pan
mode.

If you draw a zoom window that spans more than one graph, the zoom request will be
ignored. If the zoom works, the major and minor tick increments will be adjusted so that a
similar number of labels is always present along each axis. The increments that are used are 10,
25, 50, or one of these numbers multiplied by a power of 10, such as 0.25 or 500.

Zoom Commands

To zoom in a set amount on all selected graphs, select Zoom In (Ctrl-Shift-Z, think “Big
Z”) from the View menu. To zoom out a set amount, select Zoom Out (Ctrl-Z, think “Little Z”)
from the View menu. To zoom out to show the contents of the graph, choose Zoom All (Ctrl-L)
from the View menu. The contents of each graph are reviewed during Zoom All, so if curves
were edited and span more or less area than before, the zoom boundaries will be updated to
reflect this. The zoom operations affect all axes belonging to selected graphs. Usually, the X
axis is shared between all the graphs.

As long as you are not zoomed out all the way, you can pan around by pressing and
holding either the left or right mouse button and dragging it. You can also pan by holding the
Control key down and pressing one of the arrow keys on the keyboard (left, right, up, or down).
This will cause all graphs on the screen to pan the length of one major tick mark in the direction
of the arrow. You cannot pan (or zoom out) past the outer min or max. When you give the
Zoom All command, the view min and max are set to be the same as the outer min and max.
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The Status Bar

Along the bottom of the Gr window is a status bar containing information about the page.
When Gr is first started, it displays the Default Status Bar, which contains a mimimal set of GUI
components. Because of its simplicity, it updates very quickly. Optionally, the Detailed Status
Bar can be displayed instead. It displays much more information and allows the user to easily
edit the properties of curves on the page.

The Default Status Bar

The leftmost component on the Default Status Bar is a button labeled < More > which
allows the user to switch to the Detailed Status Bar. Next to this are two text fields containing
the coordinates of the point whose X value is nearest that of the mouse cursor. The X coordinate
is on the left and the Y coordinate is to its right. As the mouse cursor is moved around the graph,
these numbers are updated automatically.

< More > 107.25000 , 1.48000 Zoom X Unlocked | | Y Unlocked
The Default Status Bar

265.59375

If the X coordinate is a date and time, it can be
written in a number of different formats. Holding down
¥¥/DDD Hi:mm: 55 987265 14:15:00 the Control key and clicking on the X coordinate label will
cycle through the available formats. When the mouse is
clicked over the label, the format descriptor is written, but
¥y/MM/dd HH:mm:ss 98f09f22 14:15:00 once the mouse is moved over a time series curve, the
label will show an actual date. If the mouse is moved over
a curve that does not represent a time series, the default
hh:mm:ss aa 02:15:00 B ]abel format will be used.

Available forpat desiaepidde/be information on the status bar is the current mode: either Pan,
co'lumn) and their respective outputs Zoom, Select, or Drag. If Gris in Select or Drag modes,
(right column). the left mouse button is reserved for other operations, so
you must use the right button to pan or zoom. Clicking the Pan radio button, or selecting it from
the View menu (Ctrl-Shift-X), will put you in Pan mode from any of the other three modes.
Clicking the Zoomradio button will put you in Zoom mode, which allows you to draw a zoom
window without holding down the Shift key.

¥y¥y /DDD HH:mm 1998265 14:15

yyyy /MM fdd HH:mm 1998709722 14:15

EEE, MMM dd, ¥y¥Yy¥y Tue, Sep 22, 1998

Gr can lock the X or Y axes in place so they are not affected by zoom or pan operations.
To toggle the locks, choose Lock X (Ctrl-Alt-X) or Lock Y (Ctrl-Alt-Y) from the View menu.
The status bar at the bottom of the Gr window has two buttons which show whether the axes are
locked or not. You can click these buttons to toggle the locks. On the default status bar, these
buttons are labeled X Locked or X Unlocked and Y Locked or Y Unlocked.
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The Detailed Status Bar

The Detailed Status Bar contains all the information and control of the Default Status
Bar, but adds much more. If it is not already displayed, clicking the < More > button on the
Default Status Bar will display it. Clicking the > Less < button will switch back to the Default
Status Bar.

Choose Curve 0.00000 Axes Data Hearest Min Max [v] Show

® Under Mouse Zoom ¥ u u 112, 45800 99 85830 115.00000

() With Click >Less < i u u 0.17246 0.04525 021259

G2C1 v 362 Points [SPEED, FT/5 7] o

[¥] Line Solid - [z ; [211.00
—— | | Apply [ ——) ()

[C] Symbols | Single Pixel - 1

The Detailed Status Bar

The Detailed Status Bar is organized into four panels of GUI components. The first panel
contains a box labeled Choose Curve that lets the user choose when the status bar will be updated
with the curve that is nearest the mouse cursor. The first choice is Under Mouse and causes the
status bar to be updated each time the mouse is moved within the graph area. The second choice
is With Click and causes the status bar to be updated each time the user clicks the mouse within
the graph area.

There are three other components on the first panel. Two are the ;hsﬂze C:“e %
> Less < button and the mode indicator, which have already been neer Wouse
described. The other is a text field which describes the forlzlat which Owincick | >Less< |
should be used for displaying the coordinates of points. It uses the Panel 1
convention of j ava. t ext . Deci mal For mat as described under the
Label Format entry of the Properties Dialog. The default format is 0. 00000. The format affects
the appearance of all coordinates on both the Detailed and Default status bars.

The second panel is Axes Data Nearest Min Max [¥] Show

arranged as a table with three X u u 11z.45800 58.85830  115.00000
rows. The top row consists T u 0.17246 0.04925 0.71299

mostly of column headings. The

middl}; row is for the X : Panel 2

dimension and the bottom row is for the Y dimension. The leftmost column consists simply of
the row labels X and Y. The column next to it, under the Axes heading, has two toggle buttons
labeled either L or U, for Locked or Unlocked, and are used to lock or unlock the X or Y axes.
Under the Data column, there are two more buttons of the same type that lock or unlock the X or
Y dimensions of the chosen data series for editing. The default setting is for the X dimension to
be locked and the Y dimension to be unlocked. This allows points to be dragged up and down
without affecting their position along the X axis.

The next column is labeled Nearest and shows the coordinates of the nearest point to the
mouse as of the last update. These are the same as the coordinates shown on the Default Status
Bar. Next is a column labeled Min, which shows the smallest X and Y coordinates in the chosen
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series. Beside it is a column labeled Max, which shows the largest X and Y coordinates in the
series.

The rightmost column consists of three check boxes. The top check box allows the user
to show or hide the chosen curve. This can be useful when a curve is obscuring others and
making it difficult to see or select points on the other curves. As long as it is hidden, a curve
cannot be chosen by clicking it or moving the mouse over it. In order to show it after it has been
hidden, it must first be selected. This can be done using the curve list choice box in the third
panel of the status bar.

The two check boxes below the Show check box are permanently disabled. They tell the
user whether the X and Y dimensions of the chosen data series are sorted in ascending order. A
typical curve will be sorted in the X dimension and unsorted in the Y direction. If the X
dimension is unsorted, the curve cannot be chosen by moving the mouse over it or clicking it. If
the status bar appears to be ignoring a curve, that could be the reason. You can still choose the
curve using the curve list choice box.

The third panel on the Detailed G2C1 v 362 Points |[SPEED, FTiS |
Status Bar is arranged as three rows of vl Line Solid v |
com In th i inale Pi ’— Aoy |
ponents. In the top left corner, is the [ symbois |Single Pixel -
curve list choice box, which lists all the
. } . Panel 3
curves on the page, including hidden curves
and curves on hidden graphs. The curves are described according to their index number within
their graph and their graph’s index number within the page. For example, the third curve on the
second graph is listed as “G2 C3”.

To choose a curve from the curve list, click on the box and a list will pop up or down. If
the list of curves is long, it may have a scroll bar along the side so you can scroll to see all of the
items. If there is sufficient space below the box, the list will pop down. If there is not, it may
pop up over the graph area. If this happens, it may be best to use the With Click option in the
Choose Curve box so that your selection from the curve list will not be immediately changed
when you move the mouse cursor within the graph area.

On the top row next to the curve list is a text field displaying the number of points in the
chosen data series. To its right, is an editable text field containing the title of the chosen series.
You can edit the title the same way as you would in the Properties Dialog, hitting Enter when you
are finished.

The middle row of the third panel contains three components describing the line
connecting the data points of the chosen series. The check box can be used to turn the line on or
off. The choice box beside it gives several options for the line type, and the text field is for
changing the width of the line. The default width is one. The line you see on the screen may
differ from the PostScript output.

The bottom row describes the symbols that are drawn at each data point in the chosen
series. The check box can be used to turn symbols on or off. The choice box lets you choose
what type of symbol should be used, and the text field is for setting the size of the symbols. The
default size is five, which is the diameter, in pixels, on the screen and the diameter, in points, on
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the printed output. On the screen, all symbol types are drawn as filled squares, but they are
drawn correctly on the PostScript output. Since the Single Pixel symbol is no wider than a line, it
is drawn larger on the screen whenever the line is turned on.

The fourth panel on the Detailed Status Bar contains three ':gg
slider bars for changing the Red-Green-Blue (RGB) color of the = g [}
chosen curve. The top slider controls the amount of red, the Panel 4

middle slider controls the amount of green, and the bottom slider

controls the amount of blue. The numbers to the right give the level of each color as a number
between 0.00 and 1.00. The resulting color is displayed to the left of the sliders. Remember that
colors on the PostScript output must be enabled in the Properties Dialog and are automatically
darkened from their onscreen appearance. If you are unfamiliar with creating colors using RGB
sliders, experiment a little and read Appendix A.

Selecting and Dragging Data Points /

Each curve on the screen is actually a series | ' R '
of data points connected by straight line segments. '* [
Gr allows each curve’s data series to be edited and [
the changes saved to a file.

Selecting Points s .

To select points, first enter Select mode by
clicking the Select radio button on the toolbar, or I ]
choosing it from the Edit menu (Ctrl-Shift-S). e ]
This causes every point on the currently selected ’ T TE T —L
graph to be drawn as a small, filled square, several &
pixels in diameter. For curves with many points, A selected point
this appears to thicken up the curves but, if you
zoom in, you will see thin line segments connecting the individual points. Remember that you
must use the right mouse button to pan or zoom while in Select mode.

To select a point, move the tip of the mouse pointer somewhere over the filled square that
marks the point and click the left mouse button. If the point is selected, it will change color. Be
careful not to drag the mouse when the button is down if you only mean to select that one point.
If you have trouble using this selection technique, try using a selection window, as described
below.

To select multiple points, you can draw a rectangle from corner to corner, just like a
zoom window. To do this, move the mouse pointer so that it is not over any points, and so it is at
the corner of the selection area. Press the left mouse button, drag the mouse to the opposite
corner of the selection area, and then release the button. The first curve in the first graph, with
points within that area, will have those points selected. All other points are deselected.

To add to the selection, hold down the Control key and drag a selection box around the
new selection area. Only points on the currently selected curve will be selected. To select points
on other curves, hold down the Shift key. This allows you to select points on all curves within
the selection area, and the area is allowed to span across multiple graphs. Holding down Control
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and Shift together adds more points to the selection from every curve within the selection area.
To deselect an area, hold down the Alt key and draw a selection rectangle. If the rectangle spans
multiple graphs, you will also need to hold down the Shift key in order to deselect points on all
the graphs. The keyboard modifiers work the same way with single points. Just click on one
point at a time instead of drawing a selection rectangle.

To quickly select all the points on curves that are partially selected, choose Select All
(Ctrl-A) from the Edit menu. To deselect all points on the page, choose Deselect All (Ctrl-D)
from the edit menu.

Deleting Points

To delete the points that are selected, just hit the Delete key on the keyboard. Alternately,
click the Delete button under the Selection heading on the toolbar, or select Delete from the Edit
menu. The points that were deleted will appear as cyan marks just outside the top of the graph’s
frame. Those marks only appear in Select or Drag modes, and are used to indicate where data
have been deleted or are missing. Sometimes deleted points are marked before you have deleted
anything. That is caused if the data file that was opened indicated those points were deleted.
You cannot rely on all data files to list points that have been deleted and, by default, Gr does not
save all deleted points. If you delete all the points in a curve, the two endpoints will be restored
automatically, so the curve still can be selected.

Dragging Points

To interactively change the Y coordinates of the selected points, hold down Ctrl and
move the mouse over one of the selected points. Press the left mouse button, drag the mouse up
or down by the desired amount, and then release the mouse button. Horizontal motion is ignored
while dragging points as long as the X dimension of the data series is locked. A shortcut for
dragging a single point that is not selected is to simply move the mouse pointer over it, press the
left mouse button, and drag the point to a new location. No keys need to be held down, and all
previously selected points will be deselected before the point is moved.

The Modify Dialog

Once points have been selected, many different actions can be applied to them. The most
basic are grouped together in the Modify Selected Points dialog box (Modify Dialog). To open
the dialog, click the Modify button on the toolbar or select it from the Edit menu (Ctrl-M). It is a
modal dialog box, like the Properties Dialog, so the main Gr window cannot receive input until it
is closed. Also like the Properties Dialog, there is an Apply button.

Pressing Apply applies the action so its effects can be seen in the main window but leaves
the dialog open so other actions can be applied to the same selection. Pressing Close closes the
window without changing the selected points.

The two other buttons are Undo and Redo. They simply allow you to use the Undo and
Redo commands from the Modify Dialog. You have the same number of undo operations
available as you would otherwise.
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Choosing an Operation

x|

| Operation | ~Output —
The top left area of the Modify Dialog is (®ada Cowutipty 0 Set Equal || Mody Original
. . 15 suntrast. O iviie | e
titled Operation and has two groups of components |~ St ©owee  Cn ; o ortcarn
1 1 | Maning Auerage (@ Create New Curve
that can be used to describe what action should be === g ® Now curve
taken on the selected points. The first Operation e ol [ Beth Curves
group is made up of six radio buttons: Add, which @ constant f1.5_ I
adds some number to every selected point; (Pome  |GICHSPEDAS YO cuve2 R
Subtract, which subtracts some number from every ™= _ ||[I® Regedar =™
. . . .. EO Modify X (&) Modify Y 1 wterval ’—D @ Interpolation |
selected point; Multiply, which multiplies every nmterpolation — |
. .. . —— _ | ot l— | Averaging
selected point by some number; Divide, which ®Linear O Parabolie —
divides each selected point by some number; Set [ ooy |[ unao |[ Reso || ciose |

Equal, which sets every selected point equal to The Modify Dialog

some number; and None, which leaves each

selected point unchanged. None can be used with some of the output options to resample a curve
without otherwise changing it. The default action is None.

The second Operation group is an alternate choice to the six operators in the first Action
group. It is called Moving Average, and has two text fields associated with it: Soan, which is the
span of the moving average, and Samples, which are the number of equally spaced samples that
will be taken over the span. Unlike the other operators, the moving average is applied to all
points on any curve that has points selected. An area equal to half the span will be deleted from
both ends of the curve after the average is applied.

The Operand group contains two choices for the operand to be used with the operator
chosen from the first Action group. If Constant is selected, you can type a number into the text
field beside it. If Curveis selected, however, the operand will be an entire curve. In order to
specify a curve as the operand, Y Dimension must be selected in the second Action group. The
curves are listed according to their index within their graph, and their graph’s index on the page.
Each curve listed has the letter “G” followed by the index of it’s graph, the letter “C” followed by
the index of the curve within the graph, and the title of the curve that was assigned when it was
created.

The value of a curve operand at any given point on the X axis is the Y value of the curve
at that point. The method used to determine that Y value can be picked from the Interpolation
area at the bottom left of the Modify Dialog. When using a curve for the operand, if any selected
points have X values lower than the operand curve’s defined X range, then all points on the
output curve below that range will be deleted. Similarly, if there are selected points with X
values greater than the operand curve’s X range, all points on the output curve above that range
will be deleted.

The Dimension group is made up of two radio buttons: Modify X, which causes the X
coordinate of each selected point to be modified, and Modify Y, which causes the Y coordinate of
each selected point to be modified. Modify Y is the default. The Modify X option is disabled if
the chosen operand is a curve, or if the operation is set to None or Moving Average.
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Interpolation

The Interpolation box in the lower left corner of the Modify Dialog has two radio
buttons: Linear and Parabolic. They are used to specify which method to use when determining
the Y value of a curve at a given point on the X axis. The point may be in between the data
points which define the curve, which means the value must be interpolated. Picking linear
interpolation will cause Gr to fit a straight line between the two nearest points and use the Y
value of the line at the specified point on the X axis.

"
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Two parabolas (solid lines) are fitted through four
points and averaged to find the solution (dashed
line) that is used with parabolic interpolation.

Picking parabolic interpolation will cause Gr to fit one parabola through the two nearest
preceding points and the nearest following point, and a second parabola through the nearest
preceding point and the two nearest following points. The Y values of the two parabolas at the
specified point are averaged to arrive at the Y value that will be used. Some curves will be more
accurately interpolated with the linear method while others, such as a sine wave, would be better
suited to the parabolic method.

Output

The right half of the Modify Dialog is devoted to options related to the output of the
specified operation. At the top of the Output area are two radio buttons that allow the output to
be created as a new curve (Create New Curve), or written over the original curve (Modify
Original). Modify Original is the default choice. If you choose Create New Curve, you will also
need to specify which curves should maintain the selected region. The choices are presented in a
radio button group labeled Select. They are Old Curve, which keeps the same points selected
while creating a new curve with no selected points; New Curve, which deselects the old points
but selects those same points on the new curve; and Both Curves, which keeps the same points
selected and also selects those points on the new curve.
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Currently, Create New Curve does not entirely work with Undo and Redo because it loses
the selected points. Also, selecting New Curve or Both Curves with any output interval other
than Curve 1 can cause the wrong points to be selected on the new curve.

The Interval area describes the spacing interval of points in the output. The default is
Curve 1 which means that points will be written with the same X values as points in the selected
curve. If a curve is selected as the operand for the action, then Curve 2 becomes an option for the
output interval. It will cause points to be written with the same X values as points in the operand
curve.

The last interval choice is Regular which writes regularly spaced points. Enter the
spacing interval into the Interval text field using the units the data are stored in. The Offset text
field tells Gr where to start writing points. For example, if the data are measured in minutes and
the points should be written at 5 minutes, 15 minutes, 25 minutes, and so on, the interval should
be 10 and the offset should be 5.

Whenever an output interval other than Curve 1 is chosen, the entire curve will be
resampled. In the bottom right corner of the Modify Dialog there are two choices under
Resample With. The Interpolation choice uses the specified interpolation method to determine
the Y values for each new point. The Averaging choice uses the Y values of the old curve’s
points whenever possible. There is very little difference between the two methods when
resampling from coarsely spaced data to finely spaced data. In that case, each method uses the
chosen interpolation method to arrive at the value of each new point. Interpolate would use the
value at one point on the old curve, while Average would average the interpolated values at two
or three equally spaced places along the old curve.

P YR TSRS AN S SN AN ST T TSNS SN A SN SRS SN T T NSNS S SN SN SO S SN T AT TS NSNS SRNTIN (NSNS S S NN U AT SN A VHN SASAN NS SN S S
Resampling from a longer interval to a shorter interval using parabolic interpolation.
The original curve is represented by the thicker line with larger points.
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o 2 4 B g — il — 12 — 14 — 16 — 18 — 20 — 22 — 24 — 26 — 28
Resampling from an interval of 2 (solid line) to an interval of 9 using linear interpolation
(dashed line) and linear averaging (dotted line).

The two methods differ more when resampling from finely spaced data to coarsely spaced
data. For example, if the old curve had a point every two units on the X axis (0, 2, 4, 6, and so
on), and was being resampled to have a point every nine units, the new curve would have points
at 0,9, 18, 27, and so on along the X axis. If Interpolation is chosen, the Y value of the new
curve at X=9 would be calculated by interpolating the Y value of the old curve at X=9. If
Averageis chosen, and linear interpolation is on, the Y value at X=9 would be calculated using
the trapezoidal rule with the exact Y values from the points at X=6, 8, 10, and 12, and the
interpolated values from X=4.5 and X=13.5. If parabolic interpolation is specified, the Average
choice would average several equally spaced points along the curve between X=4.5 and X=13.5,
with the end points being weighted half.

Cutting, Copying, and Pasting Curves

You can make copies of curves before modifying them by selecting some portion of the
curve and then choosing Copy (Ctrl-C) from the Edit menu. This copies the entire curve to a
buffer, overwriting the previous contents. If multiple curves are selected, they will all be copied.
If no curves are selected when the command is given, the buffer remains unchanged. The Cut
command (Ctrl-X) on the Edit menu works the same as Copy except the original curve is
completely removed from the graph it was in.

To paste the contents of the copy buffer, select the target graph or graphs, and then
choose Paste (Ctrl-V) from the Edit menu. The entire contents of the buffer will be pasted to
each selected graph. The curves may have different line patterns or colors after they are pasted
because each graph assigns the curve the next available pattern and color, which depends on how
many curves are already in the graph. The data in the new curves are not shared with the
originals, so each can be edited independently of the others. Pasting can be used with the New
Graph command to create multiple graphs with the same content. You may need to click Zoom
All to update the graph boundaries after you cut, paste, or edit curves. You can also cut and paste
curves using the Properties Dialog.
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Undoing Operations

Most operations in Gr can be undone by choosing Undo (Ctrl-U) from the Edit menu.
This includes cutting and pasting operations, the addition or deletion of graphs, and changes to a
graph’s properties. Selections cannot be undone, but any modification made to a selection can
be, including changes made by dragging the mouse or using the Modify Dialog. Gr supports
multiple levels of undo, so giving the Undo command repeatedly will undo successive
operations. Undone operations can be redone by choosing Redo (Ctrl-Shift-U) from the Edit
menu.

The way the Undo capability is implemented is by making a copy of every selected
curve’s underlying data series in it’s entirety before edit operations are performed, or to copy the
page layout before changing curve, graph, or page properties. That way the restored state is
exactly the same as it was before the operation was performed. The alternative to this method
would be to go backwards by applying the inverse of the original operation to recreate the
original state. Although this would take less memory than storing many backup copies, it can
introduce errors and, for certain operations, such as filtering, there are no inverses.

The advantage to the way Gr handles Undo is that you do not have to worry about making
mistakes while editing, since undoing will get you back to exactly where you started. The
disadvantage is that you might run low on memory as backup copies of every curve are stored,
especially when editing very long data series. For this reason, there is a way to adjust how many
undo operations will be saved. In the Properties Dialog under GUI, there is a property labeled
Levels of Undo that has a drop down box beside it. The choices are 0, 5, 10, 20, 40, 80, and
unlimited. The default is 20. When you choose fewer levels of undo, all stored backups beyond
that number are immediately deleted from memory when you apply the change.

Gr only keeps one list of undoable operations, so layout changes are intermixed with edit
operations. That means if you first move a point, then hide a graph, then paste a curve, you
cannot undo moving the point until you first undo pasting the curve and hiding the graph. As
long as you are aware of which operations can be undone, you will be less likely to get confused

about what you are undoing.
ORIGIMNAL

Tools 02
There are several miscellaneous commands o ’—’_’RL__ ]
under the Toolsmenu. Currently, they all either M- el
help fill gaps in data series, filter data series, or an L
reformat graphs. The tools that edit data work e
much the same way as the Modify Dialog, and can "
be undone. o h___“““ '"""'\L. :
Fillers and Filters N ]
The two gap fillers are Fill Gaps Linearly —,,}
(Ctrl-Shift-L) and Fill Gaps Parabolically (Ctrl-
Shift-P). Both work the same way and the only ol “'-—-.,._‘.1 ™
difference is what the filled portion looks like g

afterwards. To use the gap fillers, select points on Gapl ﬁlllilng téc)mliquels —
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both sides of a gap and then give the command to fill it. The fillers will look for deleted points
within the range of selected points and restore all of them back to the data series. They only

work with gaps whose deleted points are shown as being deleted with cyan markers at the top of
the graph.

The linear gap filler uses the restored points to form a straight line from the nearest point
before the gap to the nearest point after. The parabolic gap filler fits a parabola through the two
points preceding the gap and the two points after the gap, using the same method as described for
parabolic interpolation in the Modify Dialog.

@5 sample.xml - Gr L - o] x| @ sample.xml - Gr L -|o] x|
File Edit View Page | File Edit View Page Tools Help
| 4 Fill Gaps b | General— |
| openFile.. | . GouinFiter T OpenfFile...
|_Properties... | Calculate Mean Properties... |
Animation »
25 6G5... Format e A5 G5
AsPS.. p——— ! s PS..
As AL s KML..
Page 1 ! page——— 1
New New
Next Next
Delete Delete p——
Graph 0 Graph °
New 1 New
Show Show
Hide | Hide
zooman || I zooman ||
-Selection——— l ! Selection——
[ mModiry | Maodify
| Delete | Delete |
2 -2
Mode Made
) Pan ) Pan
2 Zoom 100.0 1025 1050 1075 1on 128 150 ' Zoom 100.0 1025 1050 1075 1100 1125 150
# Select A @ Select
'Y
| <mare> | 0.00000, | 0.00000| Setect | Xunlacked || ¥ unlocked | [ <mare> | 0.00000 , | 0.00000| Select | XUnlocked || YUnlocked
Applying the Godin filter to a selected curve After applying the Godin filter

The filter tool that currently is on the Tools menu is Godin Filter, which is used for
filtering the tidal influence out of water data. To use it, first make sure the X units of the data are
in days, then select any part of the curve to be filtered, and select Godin Filter from the menu.
This filter resamples the data series to hourly increments, and then applies three moving
averages. The first is 12-1-11 hour, the second is 11-1-12, and the third is 12-1-12.
Approximately 1.5 days of data will be deleted from both ends of the data series.

The Godin Filter can also be used from the Properties Dialog. To do this, open the
Properties Dialog, click on the Gr node, and right click to bring up the menu. Choose Add New -
> Tool -> Godin Filter. Copy each of the DataSeries objects you would like to filter, click on the
Godin Filter node and choose “Paste Original” from the right mouse menu. Next, click the
Apply button, click on the Godin Filter node, and choose Godin Filter -> Calculate from the right
mouse menu. Many DataSeries objects can be filtered at once with this method, but the filtering
can’t be undone as it can by using the Tools menu in the main Gr window.

Drawing New Curves

You can draw a new curve by selecting Start Drawing (Ctrl-W) from the Format
submenu of the Tools menu. Once the command is given, each mouse click within a graph is
interpreted as the next point on the curve. To begin a new curve, give the Start Drawing
command again. When you are finished drawing, select the Stop Drawing command (Ctrl-Shift-
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W) from the Format submenu of the Toolsmenu. A curve must have at least two points before it
is shown. You can use the Undo and Redo commands to remove and restore the most recent
points from the curve as you draw it.

Page Formats

Formats offer a way to quickly give your plots a certain appearance on the screen or on
the printed page. They also allow each user to work with the format that best suits them. Many
of the changes made when applying a format could also be made using the Properties Dialog.
Those changes can be further modified or undone using the Properties Dialog after applying a
format. Formats can also add features to the plots that are not otherwise available, such as
automatically numbering the graphs, or writing the current date. You may need to give the
format command again after opening new files. This will cause you to lose some of the
formatting changes you have made since the last format command was given.

The Default Format command is used to apply the default format to a page of graphs,
usually after some other format has been applied. It turns off any special features of the previous
format, and returns all tick marks, grid lines, and graph titles.

The Report Format command is used for creating a page of graphs that would be suitable
for use as figures in a USGS publication. When printed, the graphs will be the proper width and
height, use Helvetica 8-point font, and proper line thickness. The command turns grid lines and
minor tick marks off on all graphs, hides the page and graph titles, and turns on X and Y titles.
The graphs on the screen are labeled A, B, C, and so on, and those labels are kept in order even
when graphs are moved around. If time series data are being viewed, the title is changed to read
“DAYS FROM JANUARY 1, ” followed by the data’s reference year.

The Working Format command adds extra information to the printed output of a page.
The format uses landscape orientation and is similar to the default format. The date and time of
the print is written in the upper left corner, and the full path names of all opened and overlayed
files are written in the upper right corner. Also, deleted points are marked as hollow circles with
an “X” through them. Most of these features only show up on printed output, with the exception
being the current file, which is displayed on the screen as well as on the printed page.

The Slide Format command is meant for generating a PostScript file that could be used as
a slide in a presentation. The background is set to black with yellow graph lines and thick,
colored curves. The PostScript font is set to 14-point Times-Bold-Italic.

Saving as XML

Gr’s main format is based on Extensible Markup Language (XML). It is the only format
Gr uses that can store data, page layout, and other program options in a single file. To save the
current page, including all data series and hidden graphs, click the As XML... button under the
Save heading on the toolbar, or select Save As XML... from the File menu. A dialog box will
appear for you to choose the name of the output file. The current page and all its child objects
will be written to that file. Use the Open File... command to open it later.

You also can create custom project files that contain any number of pages, or just data.
To do this, open the Properties Dialog, click on the Gr tree node, and right click to display the
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popup menu. Navigate through the Add New submenu, the File submenu, and select XML
Project File. An empty XML file node will be added as a child of the Gr node. To add objects
to the file, select them in the tree pane, copy them using the right mouse menu, then select the
XML file node and choose Paste Original from the right mouse menu. Next, click the Apply
button to send your changes from the Properties Dialog to the actual Gr object hierarchy. Finally,
select the XML file node, right click, and select Save As... from the Gr File sub menu. A dialog
will appear for you to choose a file name, and then the file will be written to the disk.

Saving as GS Format

After you have made changes to data from a GS format file, you can save them back to
the same data file or to a new one. Click the As GS... button under the Save heading on the
toolbar, or select Save As GS... from the File menu (Ctrl-S). A dialog box will appear for you to
give the name of the file to which you want to save. The default is the last file that was opened.
After you specify the file name, click “Save” to save it or “Cancel” to close the dialog without
saving. If you choose to save over an existing file, you must answer a confirmation dialog before
the file will be overwritten.

The file will be written out in GS format and will include only curves from the most
recently opened GS file. Curves that were opened in other formats, curves that were overlayed
from other files in any format, or curves that were pasted onto the page will not be saved to the
chosen file.

Printing

There is not any true printing facility in Gr, but you can save what you see on the screen
to a PostScript file. You can then send that file directly to a PostScript printer, or use a program
such as GSView (http://www.cs.wisc.edu/~ghost/) to view and print it. To create the PostScript
file, click the As PS... button under the Save heading on the toolbar, or select Save As PS... from
the File menu (Ctrl-P). A dialog box will appear for you to give the name of the print file.

If you are using the default format, the contents of the Gr window will be stretched to fit
the page. Other formats vary in the way they fill the page. In most formats, deleted points are
not marked on the PostScript output, even though they are shown on the screen. Rotated text,
such as on Y Axis titles, also looks different when printed than it does on the screen. The
graphics library Gr uses currently has no way to draw rotated text on the screen, so it draws it the
same as normal text. It is rotated on the printed output, however.

The file that Gr creates works as an Encapsulated PostScript (EPS) file when imported
into another application, such as a word processor. Beginning with the 2000-02-25 revision of
Gr, curves are drawn using rounded joints instead of mitered joints. This causes very jagged
curves to be drawn more accurately because it eliminates the tiny spikes that sharp mitered
corners are prone to showing. The difference is small, but noticeable.

By default, Gr attempts to reduce the number of points that are drawn. The algorithm that
it uses eliminates points that are least likely to affect the appearance of the output. It does this by
considering the horizontal and vertical scales at which the data will be plotted, and also the width
of the line that will connect the points.
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The scale at which the graph was
printed and at which LPR is
performed. This curve contains
2879 points.

Detail showing the points that were
used to define the line with LPR
Width Scale = 0.25. Thick points
represent those which were kept.
The curve was reduced to 1701
points.

Detail showing the points that were
used to define the line with LPR
Width Scale = 2.0. Thick points
represent those which were kept.
The curve was reduced to 484
points.

Figure 27
Detail showing the points that were
used to define the line with LPR
Width Scale = 10.0. Thick points
represent those which were kept.
The curve was reduced to 44 points.
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PostScript output of a black curve with LPR width scale = 10 over a red curve with LPR width
scale = 0.

Point reduction can be turned on and off in the Properties Dialog under the PostScript
Options object. Point reduction for lines and for symbols each have a check box to enable or
disable those features. The Line Reduction Tolerance parameter is the distance that a line could
be offset, measured in line widths. For example, a width scale of 0.5 would indicate that it
would be acceptable to skip any points that are within half the line’s width of it’s exact location.
The default is conservatively set to 0.25.

The Line Point Reduction (LPR) algorithm only eliminates points; it never adds or moves
points, and it never reorders points. It operates sequentially through the data series, eliminating
consecutive points that are in line with each other. The algorithm eliminates more points from
certain curves, such as those with gradual changes. It always plots the first and last points of the
Series.

You can reduce the number of points in a DataSeries itself, independent of PostScript
output, by going to the right mouse menu in the Properties Dialog and choosing Add New ->
Tool -> Line Point Reducer. Paste DataSeries objects into the tool, click Apply, and then choose
Line Point Reducer -> Calculate from the right mouse menu. There are X Scale, Y Scale, and
Line Width properties for the tool than can be modified before calculating anything. Remember,
there is no undo capability when using tools within the Properties Dialog.

The Symbol Reduction Tolerance parameter is measured as a proportion of the symbol’s
radius. The Symbol Point Reduction (SPR) algorithm works the same way as the LPR algorithm,
except it simply checks to see if a given symbol is sufficiently far from the last plotted symbol.

When the Debug Point Reduction check box is checked, the user can see which points
were eliminated in the PostScript output. After turning it on, save a PostScript file just as you
would otherwise. Then zoom in on one of the curves to see which points were plotted. All the
points are represented as small magenta squares on the screen. The symbol points that were kept
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in the output are shown as medium yellow squares, and the line points that were kept are shown
as large cyan squares with a line connecting them.

The Debug setting causes the PostScript output itself to be drawn first in red with no
points eliminated. The reduced series are then plotted in black over top. This allows any
differences between the two to stand out in red.

You can use the debugging to experiment with the tolerance settings until you decide
which is most effective. When you are done, simply uncheck the debug check box and the screen
and PostScript drawing will return to normal.

Templates

Editing graph properties to get the desired appearance can be one of the most time
consuming tasks you will perform with Gr. It can take ten minutes to type in the axis limits,
increments, labels, and titles for several graphs and to proofread them for errors. And when you
are finished, you may need to open another file and retype most or all of the same settings. To
cut down on this waste of effort, there is a way to save the appearance of a page and then apply it
later as a template.

To make a page into a template, simply save it as an XML file. Then, open a new page of
data, and choose Open XML Template... from the Page menu. The properties of each object on
the template page will be applied to the respected objects on the current page, without modifying
the data. If there are more graphs or curves on the current page than in the template, Gr will
repeatedly cycle through the template objects until all the objects on the current page have been
updated. Extra objects in the template are ignored.

Apply Template on the Tools menu is another version of the Open Template... command
on the Page menu. It is a shortcut for applying a template that already has been opened, after a
new data file has been opened. It saves the effort of reselecting the same template file every time
a new data file is opened.

There is also an Open Classic Template... command on the Page menu for opening the
templates in the old Gr template format.

Appendix A - File Format Descriptions

Gr XML Format

The Gr XML format stores the Gr object hierarchy using standard XML syntax. For an
explanation of XML, refer to http://www.xml.com/pub/98/10/guide0.html or other resources at
xml.com. The main thing to remember is that all XML files use tags set off by < and >
characters to describe a hierarchy of data. An element consists of everything between an opening
and closing tags such as <tag attributel="test”> element contents </tag>. A
single tag also can open and close an element, such as <tag attributel="test” />. A
simple XML file that defines an X-Y data series would be:

<?xml version="1.0"7?>

<gov. usgs. gr >
<dataseries numDimensions="2">
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10
20
30
40
50

10
20
20
10
50

</dataseries>

</ gov.

usgs. gr>

The preceding file describes an object called gov. usgs. gr which has one child element
called dat aseri es. The data series has one attribute that specifies the number of dimensions as
“2” for X and Y. Inside the dat aseri es element are data for five X-Y points. Notice that every
element has an opening and closing tag.

When Gr writes out an entire page in XML format, every property of every object is

written out. If these were not written, Gr would assume default values. Any part of the XML file

can be edited by hand using an ASCII editor. An example of Gr writing a page out in XML is:

<?xml

<!--US
<gov.u
<obj
<o

<o

<o

version="1.0"7?>

GS Gr Version 2000-11-08-->
sgs. gr >
class="gov.usgs.gr.visual.gl.PageOfGlGraphs" title="" showTitle="false">
bj class="gov.usgs.gr.visual.PageFormatter" />
bj class="gov.usgs.gr.visual.ps.PsOptions" psFileName="gr.ps"
psLandscape="true" psFont="Helvetica-Bold" psFontSize="8.0" psColor="false"
psLineWidth="0.5" psUniformWidth="false" psSymbolSize="5.0"
useLinePointReductionl="true" LPR1WidthScale="0.25"
useSymbolPointReduction="true" SPRWidthScale="0.25"
debugPointReduction="false" />
bj class="gov.usgs.gr.visual.gl.GlGraph" title="SPEED IN FEET PER SECOND"
showTitle="true" show="true" showXtext="true">
<obj class="gov.usgs.gr.visual.gl.GlXAxis" title="" showTitle="false"
dimension="0" showMajorTicks="true" showMinorTicks="true" showlLabels="true"
showGridLines="true">
<obj class="gov.usgs.gr.visual.Zoom" viewMin="105.0" viewMax="115.0"
outerMin="90.0" outerMax="125.0" majorTickInc="1.0" minorTickInc="0.25"
tickOffset="0.0" unitScale="1.0" labelFormat="0" />
</obj>
<obj class="gov.usgs.gr.visual.gl.GlYAxis" title="" showTitle="false"
dimension="1" showMajorTicks="true" showMinorTicks="true" showlLabels="true"
showGridLines="true">
<obj class="gov.usgs.gr.visual.Zoom" viewMin="0.0" viewMax="0.25"
outerMin="0.0" outerMax="0.25" majorTickInc="0.05" minorTickInc="0.01"
tickOffset="0.0" unitScale="1.0" labelFormat="0.00" />
</obj>
<obj class="gov.usgs.gr.visual.gl.GlCurve" title="SPEED, FT/S" show="true"
showLine="true" lineWidth="2.0" linePattern="So0lid" showSymbols="false"
symbolSize="5.0" symbolType="Single Pixel" color="Green">
<dataseries class="gov.usgs.gr.data.XyDataSeries" title="SPEED, FT/S"
numDimensions="2" numPoints="19">

<dim class="gov.usgs.gr.data.DataDimension" num="0" title="" snap="0.0"
snapOffset="0.0" locked="false" />
<dim class="gov.usgs.gr.data.DataDimension" num="1" title="" snap="0.0"

snapOffset="0.0" locked="false" />
105.5 0.17388

106 0.16506
106.5 0.15114
107 0.13981
107.5 0.13936
108 0.14822
108.5 0.16143
109 0.16611
109.5 0.14657
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110 0.11395

0

110.5 0.08667
111 0.06036
112 0.09946
113.5 0.1807
114 0.11824

</dataseries>

</obj>
</obij>

</obj>
</ gov. usgs. gr>

Notice that each element has a cl ass attribute that gives the name of the Java class that
Gr will use to represent the object within the program. The element hierarchy in the XML files
exactly matches the tree node hierarchy in the Properties Dialog, and each element’s attributes
correspond to the values in the properties table.

GS Format

GS format is the default data format of Gr. GS format stores time series data as a series
of columns in plain text format. The file is divided into a header area at the beginning of the file,
and a body area where the data values are given. There are several caveats in the way Gr reads
and writes GS format that may be useful to know, even for someone familiar with GS format.

Reading the Header

The number of header lines varies depending on the number of data series in the file. The
header of a file with one series would be eight lines long, with each additional series adding one
more line to the header. GS files created by some programs contain extraneous characters at the
ends of lines, including carriage-returns (CR). In order to count the number of lines in the
header, it was necessary to ignore these characters. Consequently, of the usual group of end-of-
line indicators (CR, LF, and CR followed by LF), only LF is recognized in the header. This has
not presented a problem thus far in reading GS files.

The official title of the file is a combination of the entire first line of the file and the date
read from the fourth line. Gr uses the file title as the page title by default. When the date is read
from the fourth line of the header, Gr looks for four integer numbers separated by spaces, with
extra spaces being ignored. The first is in columns 1-9 and represents the year. Gr can read a
four-digit year or a two-digit year using a pivot year of 60. The second number of the data is read
from columns 10-12 and represents the month. The third number is read from columns 13-15
and represents the day. The fourth number is read from columns 16-20 and represents the hour
and minute as a four-digit number. For example 1:35 pm would be given as “1335”.

The rest of line four is ignored, including the start day relative to January 1, 2000. The
four numbers at the beginning of line four are used to determine the start day. Lines two, three,
five, and six are also ignored. The number of channels, or data series, in the file is read from
columns 41-46 on line four.

For each channel, an additional line is read containing the title, data type, and decimal
offset. Gr reads these starting at line seven and continuing until each channel’s information has
been read. The title is read as a character string from columns 3-22, the decimal offset as an
integer from columns 23-28, and the data type index as an integer from 29-34. The title of each
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channel also is the title of the curve that represents it in Gr, and the first curve in each graph is
used as the initial title of the graph. The decimal offset is used when reading data from the body
of the GS file, and the data type is used to group curves of the same type on the same graph in
Gr. After all the channel description lines have been read, one other line is read and ignored
before the body is read.

Reading the Body

Each line in the body of the file gives the time in the first column followed by the value
of each series at that time in their own respective columns. The time is given as the day of the
year and decimal fraction of the day all multiplied by 100,000. For example, January 1% at 00:00
would be written as “100000” and, for a non leap year, July 5" (day 186 of the year) at 11:15 pm
would be written as “18696875”. This gives a time resolution of better than one second.

The lines in the body of the file are broken up as follows. Columns 1-9 are the date and
time as described above. There are six space columns for each channel. Following those
columns, there are four optional columns for displaying the date as year, month, day, and time.
These columns are ignored by Gr when reading.

Writing GS Format

When writing data out to a GS file, Gr writes out the exact same header lines that were
read in, just as they appeared in the original file. The body of the file is all new, however. The
original times are stored as integers so they can be written back at the exact same time steps that
were read in. Missing values are written as “999999”. If one or more of the channels has a point
that is missing from the others, it is written at its own time step and the other channels are written
as “999999”. If all data is missing at a time step, that time step is not written to the file.

Here is a sample from the beginning of a GS file:
82130

Max. spec. cond.: 39.7 ms., Min. sp. cond.: 17.8 ms.
start:-yr-mn-dy---hr days- dt-nchan-mxdig

1994 1 51200 -2191 15.00000 6 6
Station Latitude: 38 3 30 N, L Sensor depth (m below MLLW): #1=

ch-------meeeeee- name-digit-dtype-isens--ivec--iblg
Isalinity, ppt 1 5 1 0 0
2salinity, ppt 1 5 2 0 0

3temp. (degrees c) 1
4temp. (degrees ¢) 1
Sspec. cond. ms/cm 1 8 1 0 O

6spec. cond. ms/cm 1 8 2 0 O

----- days-salin-salin--temp--temp--cond--cond----yr----mn----dy--hour
570833 140 171 86 89 233999999 1994 1 5 1700

571875 140 174 86 89 232999999 1994 1 5 1725
572917 141 170 86 89 233999999 1994 1 5 1750
573958 150 164 87 88 248999999 1994 1 5 1775
575000 154 163 87 &8 253999999 1994 1 5 1800
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Other data formats

Besides GS format, there are several other formats available for reading data. They are
organized as Java classes within “packages.” The Java package for most of the formats is
gov. usgs. sf hydr o. dat a.

gov. usgs. gr. dat a. Di mensi onal Dat aFi | e is the generic parent class of the other
data formats. Currently, it does not have any input or output capabilities.

gov. usgs. gr. dat a. XyDat aFi | e reads multiple space-delimited columns of X-Y
data. The left-most column holds X data and all other columns hold Y data. There are no header
lines.

Here is a sample from the beginning of an Xy file:

260.49 -164251.72
260.50 -164367.70
260.51 -162425.36
260.52 -159537.22
260.53 —-155386.58
260.54 -151899.09
260.55 -147685.55

gov.usgs.gr.data.DelimitedDataFile will eventually replace XyDat aFi | e.
Currently, it reads files with a column format of X-Y-X-Y where XyDat aFi | e reads X-Y-Y.
The main difference is that a Del i m t edDat aFi | e can be displayed and edited in the
Properties Dialog, the same way an XML file can.

gov.usgs.gr.data. TimeSeriesDataFile is the generic parent class of all the other time-series
formats. Currently, it does not have any input or output capabilities, and reverts to Xy format.

gov. usgs. sf hydr o. dat a. GsDat aFi | e is the main Gr data format, and is described
in detail above.

gov. usgs. sf hydr o. dat a. Db1Dat aFi | e is the format written by the Hydrodynamics
Project Fortran database. It reads 13 lines of header information, followed by space-delimited
column data of the form “_YY_MM_DD_TTTT” where “_" represents spaces and “TTTT”
represents the time in decimal hours multiplied by 100. All columns to the right of the date and
time are considered to be data. The first line of the file is used as the title. The 13" line is used
to determine the title of each data series. The fields are separated by underscore characters, with
the first four fields reserved for the date and time columns. All other header lines are ignored.
Currently, Gr has no output capability for this format.

Here is a sample from the beginning of a Db1 file:

Station ID: 182130 Collection agency = USGS
Record start: 10/ 8/97 (mon/day/yr), Record end: 2?/22/722
Record length = ?? days
Station Latitude = 38 3 30 N, Longitude = 122 14 24 W
Time meridian = 120W Area = Carqg. Strait
Delta discharge average = ??. cfs., (std. dev.) 2.
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Water level time-series mean = ?27? ft.
Gage datum = NGVD 1929 + 10.00 ft.
Water level (WL) data in feet.

YRMODA _TIME W
97 10 8 1125 10.50

97 10 8 1150 10.57
97 10 8 1175 10.65
97 10 8 1200 10.76
97 10 8 1225 10.91
97 10 8 1250 11.00

gov. usgs. sf hydr o. dat a. Db2Dat aFi | e is a secondary format written by the
Hydrodynamics Project Fortran database for daily output. It reads seven lines of header
information, followed by space-delimited column data of the form “YYMMDD” followed by
columns of data. The first line of the file is used as the title. The seventh line is used to
determine the title of each data series. The fields are separated by underscore characters, with the
first field reserved for the date column. All other header lines are ignored. Currently, Gr has no
output capability for this format.

Here is a sample from the beginning of a Db2 file:

DAILY DISCHARGES of delta outflow at Sherman Island

NOTE: Discharges measured by 4 ultrasonic velocity meters.
Positive indicates flow to Bay.

Start date: 10/ 1/97 (mon/day/yr), End date: 12/30/98

Discharges are in cubic feet per second (no data = -999999.)
YYMMDD Q=cfs.
971001 21000.
971002 12700.
971003 -999999.
971004 2880.

gov. usgs. sf hydr o. dat a. D 1Dat aFi | e is a time series format used for some of
the data available on the California Department of Water Resources web site. It reads four lines
of header information, followed by space-delimited column data. The first column is the date in
the form “DDMMMYYYY_TTTT” where “_” represents a space and “TTTT” represents the
time as hour and minutes (“HHMM?”). These date and time columns are followed by columns of
data. All of the header lines are ignored. Currently, Gr has no output capability for this format.

Here is a sample from the beginning of a Dwr 1 file:

/ HI ST+CHAN RSANOO7/ STAGE/ / 15M N DWR- CD- SURFWATER/
20353

TYPE: inst-val

UNITS: feet

30NOV1997 2400 0.07000
01DEC1997 0015 0.35000
01DEC1997 0030 0.62000
01DEC1997 0045 0.88000
01DEC1997 0100 1.13000

gov. usgs. sf hydr o. dat a. NoaalDat aFi | e is a time series format used for some of
the data available on the National Oceanic and Atmospheric Administration (NOAA) web site.
There is no header and all of the columns are separated by commas and optional spaces. The
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first column is ignored. The second column is the date in the form “YYYY/MM/DD” in double
quotes. The third column is the time in the form “HH:MM” in double quotes. The fourth
column is the data itself. All other columns are ignored. Currently, Gr has no output capability
for this format.

Here is a sample from the beginning of a Noaal file:

"9414750","1997/11/30","16:00", -0.536, 0.009,0,0
"9414750","1997/11/30","17:00", -0.848, 0.005,0,0
"9414750","1997/11/30","18:00", -1.037, 0.003,0,0
"9414750","1997/11/30","19:00", -1.018, 0.004,0,0
"9414750","1997/11/30","20:00", -0.796, 0.002,0,0
"9414750","1997/11/30","21:00", -0.390, 0.007,0,0
"9414750","1997/11/30","22:00", 0.031, 0.005,0,0

Appendix B — Scripting

Gr’s scripting facility provides a way to automate common tasks within the program.
Using a text editor, you can write a list of simple commands for Gr to execute in succession.
Most of the commands mirror something you could do using the Gr graphical user interface
(GUI). The script files are set up the same way as template files and accept slash-slash and slash-
star comments. Only one command can be given per line, consisting of a case-insensitive
keyword followed by one or more parameters in double quotes. All filename parameters are
referenced from the current directory unless a full path is given. A full path must use forward
slashes (/), even on Microsoft Windows systems. Using a full path will change the current path
to that directory, so the filename parameters that follow can omit the full path if the files they
reference are in that directory.

To execute a script, click the Open File... button or select it from the File menu (Ctrl-
Shift-O), and then choose the file in the dialog that appears. If the script file ends in “. gr s, for
“Gr script,” it will be recognized and executed automatically. If it has a different extension,
choose gov. usgs. gr. Scri pt Fi | e as the file type in the File Options dialog. If Gr encounters
any unrecognized commands in the file, it will show an error dialog box, and stop executing the
script. If any of the commands in the scripts cause errors, such as a file not being found, it will
continue executing.

When Gr is first starts, it looks for a file called gr _confi g. gr s in the Gr home
directory, and executes it if it is present. (The Gr home directory is specified by the
gov. usgs. gr. gr hone variable on the command line.) This file can be used to configure Gr to
use a certain file format, or to do anything else that can be done in a script.

Each time you open or overlay a file, Gr looks for a gr _confi g. gr s file in the same
directory as the file. If it is present, it executes the script before opening the file. That way, Gr
can be made to automatically handle different types of data located in different directories.

Here is an explanation of all the available script commands. More will probably be added
in the future.

Open “filename”

Opens the specified file. Example:
Open "c:/test/data.gs"
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Overlay “filename”

Overlays the specified file. Example:
Overlay "dataZ2.gs"

SaveDataAs “filename”

Saves data to the specified file using the current file format. Example:
SaveDataAs "c:/output/newdata.dat"

SaveAsPs “filename”

Saves the page as a PostScript file. Example:
SaveAsPs "c:/figures/figl.ps"

OpenScript “filename”

Opens the specified script file and executes it. Example:
OpenScript "c:/test/test.grs"

OpenTemplate “filename”

Opens the specified template file and applies it to the page. Example:
OpenTemplate "c:/test/test.grt"

SetFormat “format”

Sets the data format for all subsequent Open and Overlay operations. Example:
SetFormat "gov.usgs.data.XyDataFile"

SelectGraph “graph number”
Selects the specified graph so it can be moved, hidden, or receive pasted curves. Deselects

all other graphs. Example:
SelectGraph "2"

SelectCurve “graph number and curve number”
Selects all points on the specified curve so it can be cut, copied, or modified. Leaves
previously selected curves selected. It is given with the letter “G” followed by the index
of it’s graph and then the letter “C” followed by the index of the curve within the graph.

Example:
SelectCurve "G3C2"

SelectAll

Selects all of any curve that is partially selected. Takes no parameters.
DeselectAll

Deselects every point on the page. Takes no parameters.
Cut

Cuts all selected curves to the buffer. Takes no parameters.
Copy

Copies all selected curves to the buffer. Takes no parameters.
Paste

Pastes the contents of the buffer to the selected graph. Takes no parameters.
Delete

Deletes all selected points. Takes no parameters.
NewGraph

Creates a new, empty graph at the top of the page. Takes no parameters.
HideGraph

Hides the selected graph. Takes no parameters.
MoveGraph “new position”
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Moves the selected graph to a new location on the page. The bottom graph is considered

number one. Example:
MoveGraph "1"

Godin
Applies the Godin filter to all selected curves. Takes no parameters.

Modify
This is the most complicated command because it takes between two and seven
parameters in any order. It works just like the Modify Dialog box. The first parameter is
Action= and has possible values of None, Add, Sub, Mul, Div, and Set, the default being
None. The second parameter is Dim= and has possible values of O (same as X), or 1 (same
as Y), with the default being Y. The third parameter is Input= and can specify either a
number or a curve, using the same format as the SelectCurve command. The default is
0.0. The fourth parameter is Interp= and has possible values of Linear and Parab, the
default being Linear. The fifth parameter is Output= and has possible values of Original
and New, with the default being Original. The sixth parameter is Interval= and is not
fully implemented, but has possible values of C1, C2, or Regular. The seventh parameter
is Resamp= and also is not fully implemented, but has possible values of Interp or Avg.

Example:
Modify "Action=sub" "Input=GlC4" "Interp=Parab"

System “command”

Issues a command to the operating system. Example:
System "move c:\test\xydata_gr_out.txt c:\test\testl_xy.txt "

Here is a sample script file that converts the first curve on the first graph from degrees
Fahrenheit to degrees Celsius and then overlays a file in Xy format and applies a previously
saved template.

// Script for converting degrees F to C.
Desel ect Al |

SelectCurve "GlC1"

Modify "Action=sub" "Input=32"

Modify "Action=div" "Input=1.8"

Desel ect Al |

// Overlay another file and apply a template.
Format "gov.usgs.data.XyDataFile"

Overlay "C:/results/filel.txt"

OpenTemplate "C:/templates/tl.grt”

Appendix C — Tips for Working with RGB Colors

Everyone sees RGB colors whenever they sit down in front of a color computer monitor.
Gr makes heavy use of colors to distinguish its various elements, so it makes sense to have a
basic understanding of how the RGB color system works.
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RGB is an additive system (as opposed to the CMYK system used for printed output) and
is used for producing colors using light. The three color components which are added together
are red, green, and blue. Computer monitors vary the amount of red, green, and blue light
coming from each pixel in order to create millions of distinct colors. Each of these spots is small
enough that they blend together and we perceive the resulting additive color.

The subtractive system in which “yellow and blue make green” works with paint or ink,
but not with light. In RGB, yellow is not even a primary color; it is the combination of red and
green. Here are definitions of some common colors and how they are created with RGB. 0
means a color is fully off, and 1 means it is fully on.

Skin tones, oranges,

Specific Colors
Black R=0,G=0,B=0
White R=1,G=1,B=1
Red R=1,G=0,B=0
Green R=0,G=1,B=0
Blue R=0,G=0,B=1
Yellow R=1,G=1,B=0
Magenta R=1,G=0,B=1
Cyan R=0,G=1,B=1
Ranges of Color
Grays R=G=B

gold, browns R>G>B
Pinks R>B>G
Swamp Green, Chartreuse G >R >B
Mint Greens G>B>R
Violets, Lavenders B>R>G

Electric Blue, Powder Blue B >G >R

Note that the color cyan is similar to aqua or turquoise, the color magenta is similar to
maroon, and brown is the same as dark yellow.

As you would expect, black is the absence of all light, and white is the presence of all
types of light. You can make a brighter shade of any color by multiplying all of the components
by some number greater than 1. You can make a darker shade of any color by multiplying all the
components by some number between 0 and 1.

Gray results whenever all three components are at equal levels. No one color stands out.
If a color is dull, but not dark, all three colors probably are at medium levels. The brightest shade
of gray is white, and the darkest shade is black.

Overall intensity is the sum of all three color components. Our eyes are slightly more
sensitive to green, so that component counts a little more than the others. Red, in turn, slightly
edges out blue. The differences are on the order of about 10%. You can test this by setting all
three color sliders to O and then increasing each individually until you start to perceive the color
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being something other than black. You should begin to perceive green at a lower level than the
others.

To create a given color, try to describe it relative to two more basic colors. The levels of
each color component will be between their respective levels in the basic colors. For example, to
make light yellow, the RGB levels will be somewhere between those of yellow (1, 1, 0) and
white (1, 1, 1). That is, red would be fully on, green would be fully on, and blue would vary
depending on how bright you wanted the yellow to be.

When you choose a color to use for a curve, you should take into account which colors
are around it. For example, bright green may look good on a dark blue background, but it does
not seem nearly as bright on a white background. This is due to contrast. Our eyes pick out
objects more easily if their color and overall intensity contrast with those of their background.

Inverting the levels of each RGB component often results in an opposing color, such as
yellow (1, 1, 0) on blue (0, O, 1). However, this does not always have the highest possible
contrast. Inverting the intensity can also yield high contrast, such as white on black.
Unfortunately, white and black are special cases, and other colors never have such highly
contrasting opposites. What appears as the highest contrast to your eye for most colors may be a
combination of opposing colors and opposing intensities, such as bright yellow (1, 1, 0) on dark
blue (0, 0, 0.2).

On a black and white device, such as a laser printer from the 20" century, the only way to
vary contrast is to vary overall intensity. A medium red line and a medium blue line will not be
distinguishable after being converted to shades of gray.

As a final note on color, remember that red-green color blindness is not entirely
uncommon, especially in men. If you want to make sure everyone can distinguish between two
curves based on color, make sure their colors differ in overall intensity, or by the levels of their
blue components.

Appendix D — Symbol Indexes
The symbol type is an integer index between 0 and 13 with the following
meanings.
Single pixel
Plus sign
X
Tick mark
Hollow circle
Hollow square
Hollow upward-pointing triangle
Hollow downward-pointing triangle
Hollow diamond
Filled circle
Filled square
Filled upward-pointing triangle
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12 Filled downward-pointing triangle
13 Filled diamond

Appendix E — Contact Information
John M. Donovan

jmd@usgs.gov

(916)278-3120

Placer Hall
6000 J Street
Sacramento, CA 95819-6129
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